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Vyznam pouziti grafu

nazornost (nutna vhodna volba typu)

prezentace a rozbory

pouziti vytvoreného grafu v MS Word nebo MS PowerPoint
vychazi vzdy z tabulky hodnot

2D i 3D grafy
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Pr. — velka datova tabulka

Fuls u 1 2 5 10 20 30 40 50 B0
1 0,86 2 155 11,39 1251 109 3 BB 22 2913
2 2 1,64 3,26 10 81 1155 1037 898 24 55 26 41
5 155 3,26 1,01 10,73 1158 8, a7 27 24 294
10 11,59 10,51 10,73 145 21 25 234 704 9,41
20 12 51 1155 1159 21 297 3,01 256 727 8953
30 109 10,37 891 25 3,01 3,54 278 855 10,8
40 = ala) =S 97 234 Jgala) 2748 1,44 B99 8,78
&0 2 24 55 2724 704 727 555 e 3 423
B0 2913 26 41 294 941 853 103 8,78 423 b33
0 41 53 37 52 424 16,04 16,43 18,3 16 b 23 706
80 44 57 40,83 45 73 18 B4 18 582 20 B8 18 22 8,04 869
80 238 21 41 24 91 8.04 837 819 6.7 3,79 433
100 44 35 40 33 45 27 17 B¢ 18,4 20 34 19,15 77 8,73
120 -
100 -
80 -
0
Q60 - "
=
40 -

20 A

Compared Samples

Rl

41 58
37 52
42 41
16,04
16 43
183
16
B.23
7 0B
B3

b 55
5,12
b,23

©Rady1 ®Rady2 ORady3 ORady4 ®Rady5 ©Rady6 © Rady7

80 80 100
44 57 238 44 55
40,53 2141 40,33
4573 249 45 27
18 BH 8,04 17 BY
18582 8,37 184
20 55 919 2034
1822 B.7 19,15

8,04 3,79 7.7
869 433 8,73
b 85 b2 b23
g9 7B 7 B4
7 BT 1,29 772
705 f72 432
90 100
—80 90 —O-100




Jednotliv

V 4

S

casti grafu

zdrojova
tabulka 20000 2001 2002 2003 2004 2005 2006 2007 2008
modré 20 18 15 10 B g 10 17 25
Zluté ) 3 a0 15 10 4 1 ) 2
CEMENE 10 13 a 10 20 a0 20 10 10
nazev grafu .
osa hodnot oblast grafu g \ mrizka
\ \ Vyvoj pocty prodanych kusu zbozi
351 30 30
, 30 - — 28
Nazev oSy > o ] 2
hodnot 2  »l& 18 2 . = modré
% B Zluté
3 10 . 10 10 10 O cervené
a 6 5
4
- LR
poplsky dat 2002 2004 2005 2006 2007 2008
B modré 15 10 6 8 10 17 25
| Zluté 30 15 10 1 5 2
O Genvené 8 10 20 0 28 10 10
/k
kateqorii Nazev osy X /
0Sa Kateqgoril 4/31




Vytvoreni grafu

e VloZzeni» typ grafu

e moznost upravovat pozdéji
jednotlivé Casti grafu
samostatné

70

60

D]? g~ [~

= = | (@
=G e E R Ese
Doporudené a Kantingenéni Odkaz
grafy CDY -
Grafy | Prohlidky Minigrafy Filtry Odkazy

? X
v

Spojnicovy

ul Tl i1 il

Nazev grafu

1000 200 i ivit] 2004 2005 2006 2007 2008

Spojnicovy graf se pouZiva k zobrazeni trendd v éase (roky, mésice a dny)
nebo kategorii, u kterjch zaleZi na pofadi. Pougijte ho, pokud mate
hodné datovych bodl a pofadi je daleZite,

Zrusit

EUR
mUSD
GBP
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Typy grafli

sloupcovy
pruhovy
spojnicovy
vysecovy
XY bodovy
plosny

prstencovy

2l

i
—
7
B
e

s
(P

paprskovy
povrchovy
bublinovy
burzovni
valcovy
kuzelovy

jehlanovy

2l

* B

—_

=5 &
m = W
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Sloupcovy graf

v [0} v v ’ ’
e zmeny dat v prubehu casoveho obdobi
7 \"4 7 14 7 = . ’ \'4
e znazorneni porovnani jednotlivych polozek
\4 . \2 4 [o] s
e pr.— prodej zbozi ruzne barvy
2000 2001 2002 2003 2004 2005 2006 2007 2008
rmodré 20 18 14 10 B o 10 17 25
Zlute ) 3 30 15 10 4 1 ) 2
Cervené 10 13 g 10 20 30 20 10 10
35 100% -
90% -
30
80% -
25 70%
20 60% -
50% -
151 40% |
10 30%
20%
> 10%
0 0% -
2000 2001 2002 2003 2004 2005 2006 2007 2008 2000 2001 2002 2003 2004 2005 2006 2007 2008
M modré Fluté M ¢ervené M modré iluté M iervené
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XY bodovy graf a spojnicovy graf

e XY bodovy graf
— zobrazuje vztah mezi dvéma hodnotami (X a Y)
— zobrazeni zavislosti nékolika velicin na jiné (napr. zavislost teploty na
case)
e spojnicovy graf
— vznikne z bodového grafu spojenim vykreslenych bod{ ¢arami
Vyvoj kurzu eura a amerického dolaru
26,00 € EUR
B TS S EE S 6666006000 W usd
24,00
23,00 Vyvoj kurzu eura a amerického dolaru
22,00 26,00 == EUR
21,00 zjzz =TT = === == USD
20,00 ] ’
BT L T T T PR
18,00 T T T , 21,00
31.7.10 5.8.10 10.8.10 15.8.10 20.8/ 20,00
19,00 ._.’.ﬂ_.—.\'_._-._.—H**hH
1800 +————F———— "7 7" 7T T 7T T T T T




VysecCovy graf

e vizualizace rozdeéleni celku na dil¢

e pf.— pfedvolebni odhady ~ **

5,60%

10,50%

s v 7

| Casti

16,90%

B KDU-CSL; 4,40%; 4%

W S7;5,60%; 6%

Odhady voleb duben 2009

B ¢ssD

B OoDS

B KSCM
sz

B KDU-CSL

B Ostatni

27,50%

35,10%

Cssb
m ODS
KSCM
mSz
KDU-CSL

m Ostatni
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Paprskovy graf

vizualizace porovnani Uhrnné hodnoty nékolika zdroji dat

porovnani probiha vzhledem k hodnoté€, ktera se zobrazuje ve
stredu mezi hodnotami

pr. — obsah vitamind v rlznych jidlech

vitamin A

vitamin E

vitamin vitamin B2

vitamin C
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Vytvoreni grafu

2000
2001
2002
2003
2004
2005
2006
2007
2008
2009
20310
2011

ELR
36,114
3a,115
32,135
31,775

32 451
30,305
20525
27 B35

213

2B 48
26315
24 565

=D

345 06
37 323

36 07
30 227
25 524
22 965
23918

2112
17 741
19 351
18 436
18 852

SBF
87 726
88 577
52 057
48 587
46 518
43118
41,99
40 961
35 073
29 892
29 453
29299

70

B0

a0

40

——FEUR

—a— IS0

30

20

'“ﬁ*‘“*h~+ﬁé+——+Hh1 GBP

10

2000 2001 2002 2003 2004 2005 2006 2007 2008 2009 2010 2011

11/31



Nastroje grafu — navrh grafu 1

VloZeni RozloZenl stranky Vzorce Data Revize Zobrazeni Napovéda Mavrh grafu Format
A — — f— T2
D Lo |Band 0o o 2oy R = a0 B | dl
Piidat prvek  Rychlé Zmenit | e | e ([T T s RS — : 7= —| | Prohoditfidek Vybrat | Zménit
rozloZeni~ | barvy ~ a sloupec data typ grafu
Styly grafdl Data Typ
maodré Zluté cervené 40
7 v 7 2000 20 5 10
nastaveni casti grafu B3 m 3
2002 15 30 g
v 7 v 2003 10 18 10 20
2004 5] 10 20 3 4
MOZNa Zmena typU grafu 2005 8 4 30 10 §~ —
2005 10 1 25
’ )4 2007 17 a 10
VYber dat 2008 ] 2 10 0
modré Zluté Cervené

zameéna reprezentace sloupct a radkd ”

30
2000 2001 2002 2003 2004 2005 2008 2007 2008 20 —
modré 20 18 15 10 B g 10 17 25 10

Zlute 5 3 30 15 10 4 1 5 2 0

cerveng 10 13 8 10 20 30 28 10 10 O ™A D X H o
O " " L O O
S $

prednastaveneé styly, rozlozeni + moznost individualniho nastaveni
presunuti grafu

— na pozici v ramci listu

— jako novy list

£

Presunout
graf

Umisténi
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Umisteni grafu

Presunout graf ? *
- Je Zvolte poZadované umisténi grafu:
B C D E F G H J K L
1 1 i 1 i 1 1 i 1 LH_J,"J ) Novy list: | Graf
2000 2001 2002 2003 2004 2005 2006 2007 2008
maodré 20 18 15 10 6 8 10 17 25 |_|J_J,‘ ® Objektv: | -
Zluté 5 20 30 15 10 4 1 5 2
Eerveng 10 13 b 10 20 30 28 10 10
Vyvoj pottu prodanych kusi
35
30
25
20
- S
15 =3 o o
Vyvoj poétu prodanych kust ‘7;
10 . 7
v
5
0 30
2000 2001 2002 2003 2004 2005 2006 2007 2008
—odrg  e—Futd —fervensd 25
20
=]
10
5
modré FlUte  ——Cervend
spojnicovy a XV | paprskowy | wysecoy | mix | Listi @ [1

Graf3 | Grafl | sloupcowy




Nastroje grafu — navrh grafu 2

moznost nastaveni casti grafu

— nazev grafu
— 0osy

— mrizka

— legenda

— popisky dat

— tabulka dat

funkce pro analyzy grafu

— spojnice trendu
— chybové usecky

35
30
25
20
15
10

5

0

PoCet prodanych kus(

modré
m7luté
m Cervené

20

10
i
2000
20

5
10

Prodejnost zbozi

25
20
17
15
10gm10 10
6 J

2001 = 2002 2003 = 2004 2005 @ 2006 @ 2007 @ 2008

10 6 17
20 30 15 10 4 1 5 2
13 8 10 20 30 28 10 10
Rok
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Nastroje grafu - format

Soubor Domi WloZeni RozloZeni stranky
Rada "modré" - \\

djf Formaétovat virbér Ooal-

ﬂ Obnovit podle stylu ATLF

Aktudini wibér Wiofit obrazce

o format j

Vzorce Data Revize Zobrazeni Napovéda Format

Navrh grafu
ﬂ\u’)’fplﬁ obrazce ~

™ - e - EOEF‘;E obrezce

“la Efekty obrazce

Styly obrazed e}

ednotlivych Casti grafu i

datovych rad
— cCastecné zavisi na typu grafu
e sloupcovy

— prekryv sloupct
— mezery mezi sloupci

e spojnicovy

— velikost, tvar a barva znacky

— zobrazeni vynasecich car

— obrys, vypln, efekty

o velikosti
e usporad

14 7

ani, ...

A

Styly WordArt

Format datové rady

Moinosti fady
GO |
~ Cara M Inatka
v Céra

Bez Eary

Pfechodova céra

* Automaticky

Barva

Prihlednost H———
§|’Fga

Typ sloZené cary

Typ pferufované &ary
Typ zakonceni £éry

Typ spajeni

Typ ipky na za&atku
Velikost Sipky na zacatku
Typ gipky na konci
Velikost Zipky na konci

["] Hiadka &4ra

R

Alternativni
text

Piistupnost

Kulaté

Oblé

7 x

T oL I

=
—
E'Q ‘e
Podokno Zarownat
vybéru

Uspofddat

Velikost ]

Format datove fady M

Moznosti fady
S 0ol

~ MoiZnosti rady
Rady

&

R #* Hlavnl osa

7

Vedlejii osa
Piekntifad ———+H—— 0%

Sitka mezery ——————  150% |

Velikost

« |2

&
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Dalsi upravy datovych rad

l 2000 2001 2002 2003 2004 2005 2006 2007 2008]
28

madré 20 18 15 10 5 B 10 17
, v Fluté & 3 a0 15 10 4 1 & 2
H [Eerveng | 10 13 5 10 20 a0 25 10 10/
e kliknutim na radu '
zména radku dat i
an
7 I 4
20 mmodré
w Fluté
[ om0 2001 2002 2003 2004 2005 2006 2007 2008] 15 ] O Eervent
rodré 20 18 15 10 5 B 10 17 2
gerveng ] 5 3 a0 i 0 1 1 5 |
[Eate ] 10 13 E 10 20 a0 25 10 10 10 4
5_
D.
2000 2001 2002 2003 2004 2006 2006 2007 2008
2000 2001 2002 2003 2004 2008 2006 2007 2008
rodré 20 18 15 10 5 B 10 17 2
Earvend & 3 a0 15 10 4 1 &
Fluté 10 13 E 10 20 E 28 10 10
L|
3
a0
a0
s 2
2 m rnodré 201 W rrodré
- " e p— W ierend
i 15 1 [] Oiluté
10
10 1
5_
5_
D_
2000 2001 2002 2003 2004 2005 2006 2007 2008
] 0
2000 2001 2002 2003 2004 ZO0A ZOOR 2007 2008




Format osy

e Format» Formatovat vyber
e u grafll pouzivat popisy os
— [vcetné jednotek]
o format Cisla
e rlzné pro vodorovnou a svislou osu

e dalSi mozna nastaveni
— zavisi na typu grafu
— minimum a maximum
— velikosti jednotek

e po kolika hodnotach se uvadi
znacky

— protnuti os
— logaritmické méritko

[+]

Format osy M E

Moznosti osy ~  Moznosti textu

SO o=l

Mez
Minimum 0,0 Automaticky
Maximum 35,0 Autormaticky
Jednothky
Hlavni 50 Butomaticky
Vedlejsi 1,0 Automaticky
Vodaor proti

® Automaticky
Hodnota na ose

Maximalni hodnota na ose

Zobrazené jednotky Zadné -

] Logaritmické
méfitko

] Hodnoty v obréceném pofadi
> Inatky
> Popisky

v Cislo

Kategorie

Cizla =

Desetinna mista: 2
Oddélovat 1000 (mezera)
Zaparna &isla:
-1234,00
1234,00
-1 234,00
-1 234,00
Kéd formatu (@

#2£0,00 Pfidat

b
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vodorovna osa

e svisla osa

[+]

Format osy

MozZnosti osy ~  MoZnosti textu

SO = M

~ Moznosti osy
Typ osy
® Automaticky vybrat podle dat
) Osa textu
Oza data
Svisla osa proting
. Automaticky
O v kategorii £islo
)V maximalni kategorii
Pozice osy
) Ma znackach
Cl Mezi znackami

(] Kategorie v obraceném pofadi

Format osy

MoZnosti textu
O O o= ol

~ MoZnosti osy

Moznosti osy

Meze
Minimum 0.0
Maximum 35,0
lednotky
Hlawni 50
Vedlejgr 1,0

Vodorovna osa proting

® Automaticky
) Hodnota na ose

Maximalni hodnota na ose

Zobrazené jednotky

[] Logaritmické
méritko

L] Hodnoty v obraceném pofadi

- KE

4

A utomaticky

Automaticky

Automaticky

Autormaticky

Zadné -
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2D grafy —
nastaveni vzhledu

tovych mén

v

oj sveé

Vyv

—+—EUR
—=—USD
—+— GBP

o
~

o
O

(@]
o

o o
<t M

[}Z2] zany

o
N

o
-

o

I U P S i i g g

tovych mén

v

oj své

Vyv

92.L'.S

166'TY

8TT'Ey

818'oY

T96'0%

185'8y

150°2S

1/5'SS

€ze'Le

2656
8v'9c

€L0'SE

eT’

TSE'6T

9¢

Z1'1e
ge9'le

9T6'€C

§96°'CC

S0E‘0€

ves
15'C€

122'0€
SLL'TE

L0'9€
GET'CE
GTT'SE

90'se
STT'9E
T

§26'8¢

'S¢

TvL'LT

I
o
~

T
o
©

(@]
Te]

o
<

o
™

Mz2] ziny

o
N

10 A

2000 2001 2002 2003 2004 2005 2006 2007 2008 2009 2010 2011
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Zmeéna dat, popis os

e moznost Upravy dat
— Navrh grafu » Vybrat data

e popis grafu z tabulky

Vybrat zdroj dat ? >
Oblast dat grafu: | =sloupcowy!SBS3:5K56 +
&1 Prohodit fadek a sloupec

Polozky legendy [Ffady) Popisky vodorovné osy (kategorie)
[ pfidat | [ Upravit | < Odebrat v 7 Upravit
modré 2000 A
Futé 2001
fervené 2002
2003
2004 v
Skryté a prazdné buriky Zrusit
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Graf funkce

e vytvoreni grafu funkce (x*2, 1/x, ...)

W= ;W o

1,5

0,5

9 10 11 1z 13 14 15 16 17 18 1% 20 21

1 2 3 8

-1

\

120

100

&0

60

40

20

1 2 3 4 5 6

7 B 9 10 11 12 13 14 15 16 17

T
18

19 20 21
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3D grafy

e nastaveni jako u 2D grafu

+ format oblasti grafu » moznosti grafu » efekty

X [

Format oblasti grafu M

Moinosti grafu ~  MaozZnosti textu
—
O Qo=

> Stin

» lare

> Mékké okraje

> Prostorovy efekt

v Prostorové otoceni

Predvolby

Otoéeni podle osy X 407
Otoceni podle osy Y 157

Otocenl podle osy £

Perspektiva 15° - |:

Vzdalenost od spodni casti

[[] Bez perspektivy

Automatické méfitko

Hloubka (% zakladny) 100

Viigka (56 zdkladny)

w

Prodejnost zbozi

Pocet prodanych kusti
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3D grafy

[
o))
i o
z
O
N
>33 o
H H B .W
>
&
o
662°6C 22

S

én

gaps [
S __

|

__|
__

etovych m

L4

Vyvoj sve

[Mz2] zany

S Q3 @ —
wmw DO 0O B
H H B )
o
[Mz2] zany



Netradicni grafy

[l
=%

Muszi Zeny

- N -
a1l E

Plosny graf se spojnicovym

Pruhovy graf s popisem

y

Tachometr

40% 30%

"

12
10
8 4
6 - =
4 +
2
™1

T T T T T T T T T
17 19 21 23 25 27 29 3

30%
20% ¢
IO’I\
0%
1

&
3
30" ., 30°
7 5 . \
\ \ 2 (,," |
" X1 ’ \ad
\ \|/ /
60% A . 3 \/ b7
Py e S L e e R
70% A
2700 | * | 9%0°
80% NS A ——
/(/ / \ \
90% 20 / 71\ A 120
100% s ~~isor
1500

". \\~.¢/’

https://office.lasakovi.com/excel/grafy/netradicni-grafy-v-ms-excelu/
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Razeni dat

e vzestupné x sestupné

— Data » Seradit

e vice sloupctl

Fetr
Alena
ladimir
Karel
“Yeranika
Fetr
Fetr

Petr
Fetr
“ladimir
FPetr
Alena
Karel
“eronika

Flegaty
Sirok4
Krotky
“esely
Ylasata
Krotky
Dlouhy

Dlouhy
Krothy
Krotky
Plefaty
Sirok
“esely
YWlasatd

I Fetr

Data Revize

[T Dotazy a piipojent

Zohrazeni

Mapovéda

B om g I

Organizace.. Akcie (Ang.. Mény (Ang.. Zemépis (.. |z

gl Sefadit

2R N

Filtr
4 Upfesnit

iZy a pfipojeni Datové typy Sefadit a filtrovat
: Petr Alena Viadimir
v Alena Karel Veronika
Alena Siroka Vladimir Petr Petr
larel Yeselj Karel
. s Petr Petr
Petr F'Iesa?y Veronika = pet pet
Kratky etr eir
Petr Dlauhy Petr Veronika Karel
Yeronika Vlasata Petr viadimir Alena
Wladimir | Krotky
Sefadit ? x

—I— Pridat drovefi

< Odstranit droveri

E@ Kopirovat droven

w || MoZnosti...

Data obsahuji zahlavi

Sloupec Razeni Poradi

sefadit podie Hodnoty bunék v| |aaiz v

Potom podle | jméno e Hodnoty bunék w Aail o
Zrudit
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Filtry

vybeér polozek ze seznamu podle kritéria jména [<Jpfiimei=]

Petr E'!eéaj[g?
Data » Filtr (zapnout/vypnout) Gadmit Kotk
Karel Yesgely

tvori se pro celou tabulku v 1. radku (zahlavi) e iy

pro vSechny sloupce et D'°“'“‘E]
; X 2 ; MR

— filtr pouze pro nektere (sousedni) Petr __ Dl

jméno  |pFijmeni Alena Siraka

/he . [ p Plagaty Wladimir  Krotky

sloupce — vybé&r (oznaleni) sloupce (G| i oty
Wladirnir  |Kratky Yeronika Vlasa!é

Karel esely Fetr Krotky

“eronika [WVlasata Petr Dlouhy

Petr Krotky

— polozky ve filtru — vSechny hodnoty v daném e o
sloupci (kromé hodnoty zahlavi)

jméno [=|piijmer~]
Pal Sefadit vzestupné
Al Sefadit sestupné

(Wie)
(Prvnich 10..)
(Wlastni )

e Dok
Fs Kratks
Pe Plegaty
Siroka
Wesely
Wasata
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Vlastni filtr

napr. vybér vsech polozek
zacinajicich urcitym pismenem

— polozka Filtry textu v daném
filtru

-

Vlastni automaticky filtr

2 ]|

Zobrazit Fadky:

Znak ? zastupuije jeden znak.
Znak * zastupuje posloupnost znakd.

pijmeni

=] [v
gl

Ma na zacatku
D) A (@ Nebo

Ma na zacatku

artovr * | pfijmeni  |=7 jméno |~ TELFM
21 Wénetkova
22 Zalezly

= |datum naroze * | vék
5.6.1980 32
6.11.1983 29

Vaclava £
Fdenék M

Sefadit od Ado 2
Sefadit od 7 do &
sefadit podle barwy

Filtry textu

[+ (Wybrat vie)
w9

v 13

[+ Autorsky
[ Bub&kova
[ celkem
[ Cipisek
[ Dudak
[ Elfové
-] Fialowd
[ Gy
[ Houska
[ Thich

[ Jelinkaova
[ Kropacek

| I S

Rovna se..
- Merovna se...
Ma na zacatku...

Ma na kondi...

m

Obsahuje...

Meobsahuje...

Wiastni filtr...

| ok

] [ Storno

1
10

16 18
9 b

1. poku| = | 2. poku *IS. Enku v!snuﬁet ~ [ kvalifika = 9 ~ | pofadi

35 ANO P
24 MNE 14.
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Zpracovani rozsahl

ejsic

4

h dat

e rozsahlejsi soubor dat (napr. body ze cviceni)

i C. kr. Prijmeni | Jmeéno | 0Os. éisle P1 p2 P3* P4 P5* P PT' P3* E Test
b et AMDERT |Lubog ADS020 30 40 8.0 G0 B0 B0 70 4.0 + 440
3 koh  |AUGUSTAMartin ADS032 40 40 8.0 G0 B0 G0 a0 8.0 + A0D0
3 net BABOYAH ana ADE2E3 20 40 8.0 a0 40 G0 a0 60 + 420
i haj BEMES |Lukas ADE035 40 40 6,0 a0 60 B0 a0 g8.0 + 440
¥ koh BERAM |Ondig] AD5240 40 40 20 G0 oo oo a0 a0 + 240
1 haj BIZFARRI | Michal AD5225 10 40 8.0 G0 20 30 a0 10 + 330
0 net BREAMDL |Tomas ADE037 oo 40 8.0 a0 60 G0 a0 8.0 + 450
1 haj BROZK  |David ADS033 30 40 10 no 60 30 B0 2.0 + 250
2 et BRYCHCI|Tomas ADS039 40 40 8.0 G0 B0 50 50 10 + 390
3 et BRI Michal AD5040 40 40 8.0 G0 50 G0 a0 &0 + 4B0
4 koh CAMPR  [Michal ADE042 30 40 8.0 a0 60 40 a0 60 + 430
= ot THZARIEL T A mia] nOENA2 an AnN an =N mni mnin ann an o AN
\Y4 =
e Cinnosti

— TFazeni, filtrovani
— skryvani sloupct a radkd (napf. kvali tisku)

e oznaceni sloupce/radku; pravé tlacitko mysi, v menu Skryt/ Zobrazit
e pozor na razeni, pokud jsou skryté sloupce (zkontrolovat, Ze se vse

seradilo spravné)
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Priklady akci se seznamem

e fazeni (podle bod{)

“
3 C. kr. Prijmeni | Jméno | 0Os. éislo P p2 P3 P4 P5* Ps* PT! P3* E Test
4 koh  JAUGUSTAMartin AD5032 40 4.0 a0 6.0 6.0 6.0 8.0 g0 + 500
] net BRY» hichal A05040 40 40 a0 G0 a0 =3l a0 50 + 450
B koh  JCERNOH(]Petr A05045 30 4.0 a0 6.0 40 410 8.0 g0 + 450
7 net BRAMNDL |Tomas AD5037 0,0 40 a0 a0 B0 =3l a0 a0 + 450
g haj BEMES |Lukag AD5035 40 4.0 &0 5.0 6.0 6.0 5.0 g0 + 440
g net  |AMDERT |Lubod A05029 30 410 a0 G0 B0 =3l 7.0 40 + 440
10 koh  JoAMPR  [Michal A05042 30 4.0 a0 5.0 6.0 410 8.0 50 + 430
i et BABOWAHJana A052R3 20 410 a0 5.0 40 =3l a0 50 + 420
s
3 | ke~ Piiime(~]| Jménd~| os.éis{~| Pt [v| P2 [+] P3 [+ P¥[v| PS5 [+| P& [+] PP [v]| P8 [v| ETes~|
B net BABOYWAH Jana A05263 20 40 g0 5.0 410 6.0 g0 a0 + 420
7 haj BEMES |Lukag A0E035 4.0 40 &0 5.0 g0 G0 50 a0 + 440
& koh  |BERAM |Ondis A05240 4.0 40 20 6,0 an 0.0 g0 an + 240
€] haj BIZZARRI |Michal ANAXAE 10 40 a0 B0 200 3.0 a0 10 + 330
10 net BRAMNDL |Tomag A0a037 no 40 g8.0 5.0 =l 6,0 a0 g8.0 + 450
i haj BROZIK  |David A05038 30 40 10 0.0 B0 30 G0 20 + 250
12 net BRYCHCI Tomas A0a039 40 40 g0 6,0 &0 a0 50 10 + 3490
13 et BRYx hdichal A05040 4.0 40 g0 B0 =] G0 a0 &0 + 450

2

3 C. kr. Prijimeni | Jméno | Os. éisle | E Test

4 net  |ANDERT |Lubog ADE029 |+ 440

5 koh  JAUGUSTAYMartin ADE032 |+ &S00

5 net BABOWAHana ADS2E3 |+ 420

7 haj BEMES |Lukas ADE035 |+ 440

a koh  |BERAN |COndigj AD5240 |+ 240

g haj BIZZARRI Michal ADE22e |+ 330
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Ukazka filtrovani

e automaticky filtr
— na vSechny sloupce x na vybér sloupct

e vybér konkrétni hodnoty
e vlastni vyber

startowni ipfijmeni  [«]jméno [+]Zt  [+]datum narozd = ]vék (+]1. poku{=]2. poku{~]3. poku{~]soutet [+]kvalifikace??? pofadi

1 Autargky Aloig fl 25,1583 28 1 =] 14 24 ME 13.
3 Cipisek Cinil h 2071581 30 5 a H 14 NE 20
4 Dudak Daniel il 31.12.15981 24 12 = 10 30 AND M4
5 Elfova Elvira 7 5.3.1981 30 g B 5 19 ME 18.
B Fialova Frantiska 7 5.12.1954 26 a] 7 3 16 NE 19.
8 Houska Hugao ful 771580 31 i 3 7 27 AND M.
Hllich lvan ful 8.1.1583 20 3 i H 23 ME 14,
10 Jalinkows Jaroslava 7 25.8.1982 29 7 =] 10 26 AND 11
11 Kropagek  Karel fl 4.7.1582 29 1 H =] 28 AND M7
12 Lupinek Lubamir | B.7. 1581 30 a] 1 H 26 | AND =S
13 Mugkova Martina | Z 20.11.15984 26 = = 5 23 ME 186.
14 Movikovd  Matdlie 7 17.3.15680 31 13 3 17 33 AND )
19 Tavarys Tohiag ful 30.5.1979 32 1] 2 7 3 ME 21
21 Vénedkova  Waclava 7 5.6.15380 31 1 16 13 35 AND 2
22\ Zalezly fdenék M B.11.1983 27 10 H ] 24 ME 14,
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